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I

Before commencing the installation

� Disconnect the power supply of the device. 

� Ensure that devices cannot be accidentally retriggered

� Verify isolation from the supply

� Earth and short-circuit

� Cover or enclose neighbouring units that are live. 

� Follow the engineering instructions (AWA/IL) of the device 

concerned.

� Only suitably qualified personnel in accordance with EN 

50 110-1/-2 (VDE 0105 Part 100) may work on this device/

system.

� Before installation and before touching the device ensure 

that you are free of electrostatic charge. 

� The functional earth (FE) must be connected to the 

protective earth (PE) or to the potential equalizing. The 

system installer is responsible for implementing this 

connection.

� Connecting cables and signal lines should be installed so 

that inductive or capacitive interference do not impair the 

automation functions.

� Install automation devices and related operating elements 

in such a way that they are well protected against 

unintentional actuation.

� Suitable safety hardware and software measures should 

be implemented for the I/O interface so that a line or wire 

breakage on the signal side does not result in undefined 

states in the automation device.

� Ensure a reliable electrical isolation of the low voltage for 

the 24 V supply. Only use power supply units complying 

with IEC 60 364-4-41 (VDE 0100 Part 410) or HD 384.4.41 S2.

� Deviations of the mains voltage from the nominal value 

must not exceed the tolerance limits given in the technical 

data, otherwise this may cause malfunction and 

dangerous operation.

� Emergency switching off devices complying with IEC/EN 

60 204-1 must be effective in all operating modes of the 

automation devices. Unlatching the emergency switching 

off devices must not cause restart.

� Built-in devices for enclosures or cabinets must only be 

run and operated in an installed state, desk-top devices or 

portable devices only when the housing is closed.

� Measures should be taken to ensure the proper restart of 

programs interrupted after a voltage dip or failure. This 

should not cause dangerous operating states even for a 

short time. If necessary, emergency switching off devices 

should be implemented.

� Wherever faults in the automation system may cause 

damage to persons or property, external measures must 

be implemented to ensure a safe operating state in the 

event of a fault or malfunction (for example, by means of 

separate limit switches, mechanical interlocks, etc.).
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0 About this Manual

This manual describes the installation, commissioning and programming of 

the following SmartWire-DT gateway 

� EU5C-SWD-CAN

The SmartWire-DT (SWD) communication system provides electromechani-

cal switchgear and pilot devices with communication capabilities. 

Support Center

The latest version of this manual can be found in other languages on the 

Internet by visiting our Support Center at:

http://www.moeller.net/en/support

By entering the search keyword "Gateway" or "SWD" into the quick search or 

by entering the document designation, e.g. MN05002002Z-DE. 

Basic information concerning the SmartWire-DT topic can be found in:

� "SmartWire-DT The System", MN05006002Z-EN

� "SmartWire-DT Modules", MN05006001Z-EN

You can find further information on the topics SmartWire-DT and the Smart-

Wire-DT modules in the following documents:

� Instructional leaflet „EU5C-SWD…“, IL05006001Z-DE

The standard EDS files can also be found in our Support Center by entering 

"SWD" as a search term.

Download Center

The XSoft-CoDeSys-2 software described in this manual, as well as the 

SWD-Assist engineering tool, can be downloaded by visiting the 

Eaton Download Center at:

http://www.eaton-automation.com

0.1 List of revisions
This is a fully revised version. and replaces version

09/11 of MN05013002Z. In contrast to previous versions, which described 

SmartWire-DT gateways for various field buses, this version only covers one 

single SmartWire-DT gateway. The following table show the most important 

changes that have been made in terms of content: 

0.2 Target group
This manual is intended for automation technicians and engineers.

Publication date Page(s) Subject New Modi-
fied

Omit
ted

01/13 65 „"Online replacement" device parameter“ j

http://downloadcenter.moeller.net/de/software.html
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Extensive knowledge of how to work with the field bus being used, as well 

as familiarity with the SmartWire-DT system, will make it easier to under-

stand the contents of this manual.

A specialist knowledge of electrical engineering is needed for commissioning 

and programming.

0.3 Exclusion of liability
All information in this operator manual was provided by us to the best of our 

knowledge and belief and in accordance with the current state-of-the-art. 

However, this does not exclude the possibility of inaccuracies so that we 

cannot accept any liability for the accuracy and completeness of the informa-

tion. In particular, this information does not guarantee any particular proper-

ties. 

The devices described here must only be set up and operated as specified in 

this manual and in the installation instructions provided with the device. The 

devices must be installed, commissioned, operated, maintained, and retrofit-

ted by qualified people only. The devices must only be used in the recom-

mended areas and only in conjunction with third-party devices and compo-

nents that have been approved by us. Only use is technically faultless 

condition is permitted. Fault-free and safe operation of the system requires 

proper transport, storage, installation and commissioning as well as careful 

operation and maintenance.If the following safety instructions are not 

observed, particularly with regard to commissioning and maintenance of the 

devices by insufficiently qualified personnel and/or in the event of improper 

use of the devices, any hazards caused by the devices cannot be excluded. 

We assume no liability for any injury or damages incurred.

0.4 Device designations and abbreviations
� EDS - Electronic Data Sheet

� PDO - Process Data Objects

� SDO - Service Data Objects

Following designations XSoft-CoDeSys-2 are used:

� Module - SWD module

� Station - Coordinator

� Station address - Address of the field bus module 
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0.5 Reading conventions

Symbols used in this manual have the following meanings:

a

▶ Indicates instructions to be followed.

For greater clarity, the name of the current chapter and the name of the cur-

rent section are shown at the top of each page.

 DANGER

Warns of hazardous situations that result in serious injury or 

death.

 CAUTION 

Warns of the possibility of hazardous situations that could result 

in slight injury or even death.

NOTICE

Warns about the possibility of material damage.

￫ Indicates useful tips.



0 About this Manual

0.5 Reading conventions

6 SmartWire-DT Gateway EU5C-SWD-CAN 01/13 MN120002Z-EN www.eaton.eu



1 SmartWire-DT Gateway® EU5C-SWD-CAN

1.1 Proper use

SmartWire-DT Gateway EU5C-SWD-CAN 01/13 MN120002Z-EN www.eaton.eu 7

1 SmartWire-DT Gateway® EU5C-SWD-CAN

1.1 Proper use
EU5C-SWD-CAN SmartWire-DT gateways are used to establish a connection 

between a SmartWire-DT line, together with its SmartWire-DT modules, and 

a higher-level controller.

SmartWire-DT is not designed for transmitting safety-relevant signals and 

must not be used as a replacement for controllers such as burner, crane, and 

two-hand safety controllers.

Despite the above, SmartWire-DT can be used in applications with safety 

categories of up to 3, PL d as per EN ISO 13849-1 and SIL Cl2 as per 

EN 62061 if specific add-ons are incorporated. For more information, please 

consult manual "SmartWire-DT Modules", MN05006001Z-EN.

1.2 Overview of functions
EU5C-SWD-CAN gateways are used to connect a SmartWire-DT line with 

CANopen and make it possible to access the data of up to99  SmartWire-DT 

modules . These gateways can be integrated as modular field bus modules 

into control systems that use this type of communications. This makes it 

possible to access the data of every individual module from the controller.

 

Figure 1: Connecting the field bus and SmartWire-DT with a gateway

The integrated Ethernet switch on the device is used to connect Standard 9-

pin D-sub plug . The SmartWire-DT line, along with its modules, is connected 

to the gateway. The ribbon cable, with the SWD modules and all connection 

components - such as blade terminals and external device plugs - is referred 

to as the "SWD line."
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Terminals for two 24-V power supplies are available: POW for the gateway 

and the SmartWire-DT modules and AUX for powering the contactor coils if 

these are also operated via SmartWire-DT modules.

The 8-pin ribbon cable is used to run data communications, as well as the 

power for the SmartWire-DT modules and the contactor coils, from the gate-

way to the modules. 

The diagnostic port is used to connect to a computer in order to run the SWD 

assist planning and commissioning program.

When working with an EU5C-SWD-CAN gateway, this interface can also be 

used to update the operating system.

1.3 Versions

a Power supply, 24 V DC POW

b Fieldbus interface

c Diagnostics interface

d Configuration buttons

e LED indicators: POW, CAN, Config, SWD

f Power supply, 24 V DC AUX

g SmartWire-DT connection

h Dip switch for address setting

Figure 2: Front view 
EU5C-SWD-CAN

f

g

e

d

c

b

a

h
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1.4 Important data for engineering

In connection with the SmartWire-DT modules, the gateway appears as a 

modular module on the relevant field bus. The following gateway can be run 

on the field buses specified below: 

Each SmartWire-DT module is presented as a separate module, with its data, 

to the field bus master. 

The following number of SmartWire-DT modules is the maximum number 

that can be run on the gateway:

Make sure to take the maximum volume of data that can be transmitted on 

the field bus into account. The corresponding limit will be defined by the field 

bus.

The following applies when using CANopen: 4 TX and 4 RX PDOs with 8 

bytes of data each are provided to each field bus module, i.e., 32 bytes in 

each direction. Together with the reserved PDOs corresponding to other 

modules (node ID offsets 32/64/96), this means that there are a total of 4*32 

= 128 bytes of payload data available in each direction.

The SmartWire-DT line may be extended up to 600 m.

1.4.1 Field bus connection
The connection to the gateway uses a plug. A 9-pin D-sub plug is used in 

order to connect to the field bus.

Gateway Fieldbus

EU5C-SWD-CAN CANopen, according to DS301.4 profile  

Gateway Maximum number of modules at the SWD line

EU5C-SWD-CAN 99

Field bus-slave Max. input data [Byte] Max. output data [Byte]

CANopen 128 128

￫ Information about the volume of input and output data of an 

SWD module is provided in the Appendix of the manual "Smart-

Wire-DT Modules", MN05006001Z-EN.
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Figure 3: Assignment of the connection plug for CANopen at gateway

1.4.2 Baud rate
The gateway supports operation with the relevant field bus masters up to the 

following Baud rate: 

The unit will adapt to the field bus master's Baud rate automatically.

EU5C-SWD-CAN gateways feature an automatic baud rate detection func-

tion that scans the baud rate being used on the field bus and then sets the 

unit to this fixed baud rate. This function is only run when the gateway is 

powered on, i.e., it is not used cyclically to synchronize the baud rate 

afterwards.

1.4.3 Valid device field bus addresses

CANopen SUB-D 
plug

Signal

1 –

2 CAN_L

3 GND

4 –

5 –

6 GND

7 CAN_H

8 –

9 –

1

6
7

8
9

2
3

4
5

Fieldbus Maximum data baud rate
in MBit/s

CANopen 1 

Data bus Address Address setting with 
dip switch

Valid address range

CANopen Node ID 3 - 8 1 - 32
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2 Installation

SWD gateways must only be installed and wired up by qualified electricians 

or other persons familiar with electrical engineering.

The SWD gateway is installed in the following order:

� Adjust the field bus adresse at the device.

� If the SWD gateway is the first or last module on the CANopen  field 

bus, activate the bus termination resistor in the device.

� Mount the device.

� Connect the power supply.

� Connect the SmartWire-DT line.

� Connect the field bus.

2.1 Setting the gateway's field bus address
Before mounting the device, set the field bus address by using the DIP 

switches (DIP = Dual Inline Package). The DIP switches are located under a 

cover on the right side of the gateway. 

, 

Follow the example below in order to configure an address  on the gateway - 

18 (decimal) is used as an example in this case:

18dec= 16 +2 = 1· 24 + 1 · 21 

The address is to be set at the dip switches.

for EU5C-SWD-CAN the following applies:

▶ Use DIP switches 3-8 to set the  CANopen address. For a list of valid 

addresses, refer to ￫ Section “1.4.3 Valid device field bus addresses”, 

page 10.

NOTICE

Changes made to the dip switches' settings will take effect only 

after the power supply is turned off and back on again.

DIP Switch

1 2 3 4 5 6 Description

25 24 23 22 21 20

OFF ON OFF OFF ON OFF Setting the gateway's field bus address to a value of 18dec
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Figure 4: Setting the field bus address on an EU5C-SWD-CAN gateway

2.2 Activating the bus termination resistor for CANopen
If the EU5C-SWD-CAN gateway is the first or last module, the integrated bus 

termination resistor can be activated by using DIP switch 1.

▶ Set DIP switch 1 to the "ON" position.

Figure 5: Activate the EU5C-SWD-CAN bus termination resistor

2.3 Mounting Considerations
Install the EU5C-SWD-CAN gateway in a control cabinet, a panelboard, or an 

enclosure in such a way that the power supply and terminal connections can-

not be touched accidentally during operation. Snap the device onto an IEC/

EN 60715 top-hat rail or fix it in place using fixing brackets. EU5C-SWD-CAN 

gateways can be mounted either vertically or horizontally.

For ease of wiring, leave a clearance of at least 3 cm between the device ter-

minals and the wall or adjacent devices.

 EU5C-SWD-CAN 

Example: Address 18dec

OFF

ON

2 3 4 5 6 7 81

1
2
4

8
16

32

Bus termination resistor

OFF

ON 2 3 4 5 6 7 81

OFF

ON

2 3 4 5 6 7 81

1
2
4

8
16

32



2 Installation

2.3 Mounting Considerations

SmartWire-DT Gateway EU5C-SWD-CAN 01/13 MN120002Z-EN www.eaton.eu 13

2.3.1 Mounting the EU5C-SWD-CAN gateway on a top-hat rail
Before mounting the device, make sure that you have set the device's field 

bus address and, if necessary, that the bus termination resistor (if any) has 

been activated with the corresponding DIP switch.

Figure 8: Mounting on top-hat rail

▶ Place the EU5C-SWD-CAN gateway on the top-hat rail's upper edge in 

an inclined position. Lightly push the device down and against the top-

hat rail until it snaps into place over the top-hat rail's lower edge.

The spring mechanism will make the EU5C-SWD-CAN gateway automati-

cally lock into place.

▶ Check that the gateway is seated firmly.

The device is mounted vertically on a top-hat rail in the same way.

Figure 6: Vertical mounting Figure 7: Horizontal mounting 

3
0

 m
m

(1
.1

8”
)

3
0

 m
m

(1
.1

8”
)

30 mm

(1.18”)

30 mm

(1.18”)

1

2

3

4
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2.3.2 Screwing the EU5C-SWD-CAN gateway into place
For screw fixing, you will need two fixing brackets that can be used on the 

back of the EU5C-SWD-CAN gateway. Fixing brackets ZB4-101-GF1 are avail-

able as accessories.

2.4 Potential Relationship between the Components
The entire SmartWire-DT system operates on a common supply voltage. Pro-

vide a common star point for the earth wiring. In this way the various mod-

ules in the SmartWire-DT system will not be electrically isolated from one 

another. The field bus and the SmartWire-DT system are electrically isolated 

from one another.

Figure 9: Inserting a fastening 
bracket

Figure 10: EU5C-SWD-CAN screw fixing

CLIC
K !

M4
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2.5 Connecting the power supply

The gateway and the SmartWire-DT modules are powered via the POW ter-

minals. The Gateway uses the voltage at POW to generate the 15-V supply 

voltage for the SmartWire-DT modules with a maximum output current of 

0.7 A.

If loads or contactor modules are also connected via the SWD line, the 24-

VDC control voltage for the loads must be supplied in addition to the device 

supply voltage. The AUX terminals are used for this purpose.

Take into account the total power consumption and the voltage drop in your 

SWD line and, if necessary, include additional supply units, such as power 

feeder modules, in your design. The SWD assist software program will pro-

vide support when you are carrying out the corresponding calculations. In 

addition, it will automatically let you know if additional power supply modules 

are required for your design.

The manual "SmartWire-DT The System", MN05006002Z-EN, contains 

detailed calculation examples.

Figure 11: Connection of power supply

 DANGER

In safety-relevant applications the power supply providing 

power to the SmartWire-DT system must feature a PELV power 

supply unit (protective extra low voltage).

 DANGER

The gateway has protection against polarity reversal for the 24-

V-DC-POW supply. If, however, the gateway is connected to a 

grounded device, e.g., a computer, via the diagnostic interface, 

the gateway may be destroyed if the polarity of the power sup-

ply is reversed!

24V
0V

AUX

24 V DC

0 V

POW

24V
0V

F1 F2
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▶ Connect the 24 V DC voltage to the connection terminals POW on the 

front side of the gateway.

▶ If necessary, connect the 24 VDC voltage for the contactor coils to the 

AUX terminals.

▶ Connect the POW and AUX supply voltages via separate miniature cir-

cuit-breakers or fuses.

Miniature circuit-breaker F1 for POW

� Cable protection in accordance with DIN VDE 0641 Part 11, IEC/

EN 60898:

� Miniature circuit-breaker 24 V DC rated operational current 3 A;

trip type C or

� Fuse 3 A, utilization class gL/gG

� Cable protection for cable AWG 24 in accordance with UL 508 and CSA-

22.2 no. 14:

� Miniature circuit-breaker 24 V DC rated operational current 3 A;

trip type C or

� Fuse 3 A

Miniature circuit-breaker F2 for AUX

� Cable protection in accordance with DIN VDE 0641 Part 11, IEC/

EN 60898:

� Miniature circuit-breaker 24 V DC rated operational current 3 A;

trip type Z or

� Fuse 3 A, utilization class gL/gG

� Cable protection for cable AWG 24 in accordance with UL 508 and CSA-

22.2 no. 14:

� Miniature circuit-breaker 24 V DC rated operational current 2 A;

trip type B or

� Fuse 2 A
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2.6 Connect SmartWire-DT®

▶ Grab the end of the SWD line that has an arrow pointing away from the 

blade terminal. 

▶ Plug this blade terminal into the gateway's SmartWire-DT connection.

To do so use the SmartWire-DT cable SWD-4-100LF8-24 and the SWD-4-

8MF2 relevant blade terminal or prefabricated cables of type SWD-4-(3/5/

10)F8-24-2S.

Figure 12: Connection SmartWire-DT

￫ Detailed instructions explaining how to assemble a SmartWire-

DT external device plug (SWD4-8SF2-5) onto an 8-pin Smart-

Wire-DT cable can be found in "SmartWire-DT The System", 

MN05006002Z-EN, in the "Assembling external device plug 

SWD4-8SF2-5" section.

SWD4-…LF…

SWD4-8MF
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2.7 Connect field bus

CANopen 

For connection to the CANopen cable you require a 9-pole D-SUB socket. 

(e.g. PS416-ZBS-411)

▶ Connect the CANopen cable with the CANopen plug to the gateway's 

field bus interface.

Figure 13: EtherNet/IP or Modbus-TCP
 CANopen

off

on
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2.8 Connecting the diagnostics interface

The EU5C-SWD-CAN SmartWire-DT gateway features a serial interface on 

the front. By using a programming cable, you can connect it to a computer 

and do the following with the corresponding software:

� Online SmartWire-DT line diagnostics using the SWD assist program

� Generate and export a project-specific INI file.

� Updating the operating system.

You can use any of the following programming cables:

Table 1: Programming cable for the connection to a PC

Figure 14: Configuration of the serial interface.

Device Programming cable Baud rate

EU5C-SWD-CAN EU4A-RJ45-CAB1 –

EU4A-RJ45-USB-CAB1 38.4 kBaud

Pin RS232

8 8 RxD

7 7 –

6 6 –

5 5 TxD

4 4 GND

3 3 –

2 2 –

1 1 –
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2.9 Wiring in accordance with EMC requirements

Undesired faults can occur on the field bus due to electromagnetic interfer-

ence. This can be minimized beforehand by the implementation of suitable 

EMC measures. These include:

� EMC-conformant system configuration,

� EMC compliant cable routing,

� Measures designed to reduce potential differences

� the correct installation of the field bus system

(cable, connection of the bus connectors, etc.),

� Using shielding

Figure 15: Field bus shielded by using a shield

for top-hat rail for mounting plate

M4

ZB4-102-KS1

ZB4-102-KS1

FM 4/TS 35
(Weidmüller)

KLBü 3-8 SC
(Weidmüller)
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3 Commissioning

Before switching on, check whether the power supply for the gateway is 

connected correctly. The configuration and installation of the SmartWire-DT 

line must also have been carried out correctly with all modules connected.

Commissioning takes place in several steps:

1 Commissioning the SmartWire-DT line

2 Take the field bus into operation.

3 Load and start the PLC program.

Rules for successfully commissioning an EU5C-CAN

Make sure to follow the rules below in order to successfully commission the 

gateway:

To operate the device, the target configuration must be stored. The device 

will only startup up error-free if the actual configuration at the start matches 

the target configuration.

3.1 Putting the SmartWire-DT® into operation
￫ Chapter 7 "What you need to know about SmartWire-DT®“, page 55 goes 

over the terms and basic knowledge related to SmartWire-DT.

Before the gateway can exchange data with the PLC, the target configuration 

needs to be imported and stored in the gateway. The target configuration will 

be compared with the current actual configuration every time the gateway is 

started. During this process, the gateway will determine whether there are 

any SWD modules that cannot be reached or whether a wrong type of mod-

ule is plugged into the SWD line. SmartWire-DT's response to any detected 

discrepancies will depend on how the device parameters for the SWD coor-

dinator and the SWD modules have been configured ￫ Chapter 7 "What 

you need to know about SmartWire-DT®“, page 55. 

 DANGER

If you already have integrated devices and equipment in a sys-

tem, block off any parts of the system that are connected to the 

working area in order to prevent access. This will ensure that no 

one will be injured if the system behaves unexpectedly, e.g., 

motors start up unexpectedly. 

 DANGER

Switch off the power supply whenever you are reconnecting 

modules in the SmartWire-DT system.  The SmartWire-DT mod-

ules may be permanently ruined otherwise!
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If a SmartWire-DT module drops out, it will be possible to continue running 

the SmartWire-DT line with the remaining modules. This applies even after 

the gateway is restarted or switched on again later. Please note that the 

application program can always be used to diagnose cases in which a SWD 

module has dropped out.

Import the target configuration in the following cases:

� Initial Commissioning

� Replacement of a defective module

� Whenever the SWD module layout on the SWD line is changed

The online functions of the SWD assist software offer a wide range of 

options for the display and the diagnostics functions of the SmartWire-DT 

line even without the active PLC ￫ Section “7.8 SWD assist”, page 72.

3.1.1 Reading of target configuration
The target configuration needs to be imported the first time the device is 

commissioned, whenever a module is replaced, and whenever the SWD 

module layout on the SWD line is changed.

Requirements that must be met in order to import the target configuration:

� All SmartWire-DT modules are connected to the SmartWire-DT line.

� The SmartWire-DT line is connected to the gateway.

� Voltage POW is applied to the gateway and the POW LED lights up.

� Configurated power feeder module are connected.

� The SmartWire-DT status LEDs of the SWD modules are on or are flash-

ing.

▶ Press the configuration button on the gateway for at least two seconds. 

The SWD-LED on the gateway begins to flash orange. The SWD-LEDs 

on the SmartWire-DT modules also flash.

All modules are addressed in sequence, the complete configuration is stored 

retentively in the gateway as target configuration. After this the SWD-LED 

lights green, continuous light.

￫ The target configuration should only be imported for SWD lines 

that have all the corresponding SmartWire-DT modules.

NOTICE

If you press the configuration button and a SWD module is 

missing or has dropped out from the SWD line, only the mod-

ules up to the device that dropped out will be assigned an 

address and stored. It will not be possible to use the remaining 

modules until the defective module is replaced and the configu-

ration is imported again by pressing the configuration button.



3 Commissioning

3.2 Take the field bus into operation

SmartWire-DT Gateway EU5C-SWD-CAN 01/13 MN120002Z-EN www.eaton.eu 23

3.1.2 Switching on when the target configuration is stored
If a target configuration is already stored in the gateway, the system will 

check, every time the gateway is switched on, whether the modules that are 

actually on the SWD line match the target configuration in the gateway. The 

SWD LED on the gateway will indicate the result of this check ￫ Section 

“7.7 LEDs on the device”, page 71.

3.2 Take the field bus into operation
If you are putting the field bus into operation for the first time, you will first 

have to set up the PLC programming environment  ￫ Chapter 5 "Take 

XSoft-CoDeSys-2 into operation“, page 31 

 Generally speaking, the following basic initial commissioning steps need to 

be carried out:

1 Add the standard EDS files to the PLC programming environment.

2 Open or create the project in the PLC programming environment.

3 Search for the field bus master in the PLC programming environment 

(target system) and Set the baud rate, e.g.,1.5 MBaud.

4 Select the gateway as a field bus module.

5 select the SmartWire-DT

6 Configure the gateway's and the SWD modules' parameters in the PLC 

programming environment

￫ If the target configuration import process cannot be started and 

the SWD LED is showing an orange light, disconnect the Smart-

Wire-DT gateway's field bus connection and try importing the 

target configuration again.

￫ If the SWD LED shows a solid red light, no addresses have 

been assigned to any of the SWD modules. If this happens, 

check the SWD line - especially the SmartWire-DT connection.
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3.2.1 Creating field bus communication CANopen
The green SWD LED on the gateway is used to indicate that the gateway 

and the SmartWire-DT line are communicating successfully. This is a prereq-

uisite for communications between the gateway and the PLC via the field 

bus.

With configuration check

▶ Check, in XSoft-CoDeSys-2, whether "Generate SDOs for module list" is 

enabled in "PLC Configuration" -> "CAN Module Selection" tab.

▶ Load the program into the PLC.

The CAN field bus' configuration will be transferred to the CAN master when 

the program is loaded into the PLC. If you are using an Eaton CAN master, 

the master will transfer the planned SmartWire-DT configuration for the 

SmartWire-DT line to the gateway and check it against the target configura-

tion. This configuration check is an Eaton service that is not available in stan-

dard CAN configurators. Please note that the "Generate SDOs for module 

list" check box needs to be enabled in order for this service to work. 

If the planned SWD configuration matches the target configuration stored on 

the gateway, the CAN LED will show a solid green light. The CAN LED and 

the Config LED will be used to indicate any errors that occur ￫ Section 

“Table 11: LED SWD coordinator”, page 71.

Without configuration check

If you are using another manufacturer's CAN master, you will not be able to 

load the planned SWD configuration into the gateway. Because of this, make 

sure to disable the configuration comparison in this case. 

If you do not want the system to carry out this configuration check, follow 

the steps below:

▶ In XSoft-CoDeSys-2, the "Generate SDOs for module list" option must be 

disabled in "PLC Configuration" -> "CAN Module Selection" tab.

▶ Open the "Service Data Objects" tab.

▶ In the "Service Data Objects" tab, find the object with index 0x2003 and 

sub-index 0 and set the "Disable configuration check" parameter to a 

value of "1".

▶ Load the program into the PLC.

The configuration check will be disabled. This means that the compatibility 

list cannot be used accordingly. The user themselves must check whether 

the target configuration matches the planned SWD configuration.

If the SWD, Config, and CAN LEDs show a solid green light, you have suc-

cessfully completed the commissioning process. 
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3.2.2 CAN-LED status display

Table 2: CAN-LED at SWD gateway

3.2.3 POW status display

Status CAN-LED Data exchange 
Gateway - PLC

CAN interface inactive off No

Baud rate detection active on the CAN bus Red strobe light No

CAN baud rate detected ,waiting for a valid 
target configuration

Orange No

Communication error on the CAN bus (error 
warning level reached.)

Red flashing yes

Monitoring error
(node guarding/heartbeat)

flickering red flashing light only SDO

Communication error on the CAN bus (bus 
Off.)

red no, 
but NMT is possible

Pre-operational initialization mode - communi-
cation only possible via SDOs

Green flashing only SDO

Stopped - no data exchange Green strobe light No

Operational - data exchange is possible via 
PDOs and SDOs

Green yes

Description POW

Device ready for operation on

If the other three gateway LEDs are permanently red, the operating system or the 
hardware is faulty.
If they show continuous orange light, the gateway is in Firmware Update mode. 
This mode can be deactivated by switching on the power supply again.

off
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4 Description files for  CANopen

In order to be able to run the SWD gateway on a  CANopen field bus, the 

SWD gateway's properties must be stored in a description file. This file fol-

lows specific standards for the corresponding field bus and can be loaded 

into the PLC programming environment for the field bus master being used.

The EDS file contains all the properties of a SWD gateway in its role as a field 

bus module. Since SWD gateways are modular field bus modules, this EDS 

file will also contain the properties of the potential SWD modules as inputs/

outputs.

This is why new developments in SmartWire-DT, as well as the addition of 

new SWD modules, will result in new and different versions of gateway EDS 

files.

Make sure that you are working with the latest version of the standard EDS 

files in your PLC programming environment. Check whether there are avail-

able updates for the files at our Support Center ￫ Page 3.

The selected EDS file must be appropriate for the SWD modules that you will 

be running with SmartWire-DT. In turn, this will also require you to use a spe-

cific operating system version, as well as a specific hardware device version.

For CANopen, we recommend loading the operating system version that cor-

responds to the EDS file's version.

Updating the operating system

For more information on how to update the operating system, please refer to 

the Online Help function included in SWD-Assist version 1.10 and higher. 

Enter "Update operating system" under the "Search" tab.

In the case of EU5C-SWD-CAN, the versions are updated via the diagnostic 

interface by using SWD-Assist.

￫ Please note that not all EDS files support all SmartWire-DT mod-

ules.
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4.1 Where are the standard EDS files?

There are multiple versions of each EDS file available for the CANopen gate-

way. The latest version will contain the descriptions for all currently available 

SWD modules.

The first EDS file for the EU5C-SWD-CAN CANopen gateway is named 

"EU5C-SWD-CAN.eds", version 1.0. All newer versions are named 

"EU5C-SWD-CANxxxx.eds", where "xxxx" = "_V110" for version 1.10 and so 

on.

To download the standard EDS file, please visit our Support Center 

￫ Page 3. To find it quickly, simply enter "SWD" or "EDS" as a search term.

▶ Click on "Download" to the left of  "EDS file for the CANopen SmartWire-

DT gateway....".

▶ Select the latest version, save it, and unzip the .zip file in a project folder 

of your choice.

4.2 What is a project-specific INI file
In addition to the standard ESD file, you can also use SWD assist to generate 

a project-specific INI file. Eaton PLC programming environments come with a 

service that makes it possible to import this INI file. The selection of SWD 

modules on the SWD line will already be assigned to the EU5C-SWD-CAN 

modular field bus module.

If you load the project-specific INI file into the PLC programming environ-

ment, the SWD modules will be shown directly under "Selected Modules," 

eliminating the need to tediously select each individual SWD module 

manually￫ Section “5.3.1 Select the SmartWire-DT modules”, page 33. In 

addition, this will prevent you from selecting the wrong SWD modules by 

accident.

Follow the steps below in order to generate a project-specific INI file:

▶ Start SWD assist.

▶ Switch to the Communication view by clicking on the "View" -> 

"Communication View" menu option.

▶ Click the "Online" button.

The program will show the target configuration, but this configuration will not 

be in the Project view yet.

▶ Click on the button "Device =>PC".

The target configuration will be loaded into the Project view.

▶ Click on the “Offline” button.

▶ Switch to the Project view by clicking on the "View" -> "Communication 

View" menu option. 

▶ Click on the menu option "Project"->"Export Configuration".

▶ Specify the project folder as the storage location and confirm with 

"Save."
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SWD assist stores the GSD file under the name of the current project with 

the appropriate extension, such as "SWD_Proj.ini". This can be installed in 

XSoft-CoDeSys-2 in the same way as the standard EDS file.

4.3 Versions of description files
To download an overview table showing which description file has to be 

used in order to be able to add your SWD modules to your PLC configuration, 

please visit our Support Center ￫ Section “ Support Center”, page 3 and 

enter "SWD" into the Search field.

The "SmartWire-DT Modules" manual defines the applicable device version, 

operating system version, and description file version requirements for each 

SWD module in detail.
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5 Take XSoft-CoDeSys-2 into operation

An EDS description file (EDS = Electronic Data Sheet) is used for integration 

of the gateway and operation via the field bus CANopen. The EDS file con-

tains standardized descriptions of the CANopen modules 

￫ Chapter 4 "Description files for CANopen“, page 27.

.

5.1 Select field bus master 
The connection of a SWD line via the EU5C-SWD-CAN gateway to the con-

troller XC200 is described in this chapter. Please check beforehand whether 

you have a current XSoft-CoDeSys-2 version installed with the necessary 

EDS file.

Then please proceed as follows:

▶ Start XSoft-CoDeSys-2 and open a project.

▶ Open the "PLC configuration“ and tick the destination system, e.g. „XC-

CPU201...".

▶ Use the "Insert"-> "Attach subelement" ->"CAN master" menu option to 

insert the CAN master.

Figure 16: Inserting the CAN master in the
XSoft-CoDeSys-2 PLC Configuration window
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5.2 Integrate library

The "3S_CANopenMaster.lib" library coordinates data communications for 

the selected modules in the PLC configuration.

The XSoft-CoDeSys-2 PLC programming environment will automatically add 

the CANopen libraries as soon as a CAN master or CAN device is added to 

the PLC configuration.

In order to add the library manually, follow the steps below:

▶ Click on the "Window" -> "Library manager" menu option.

▶ If the file is not found in this window, select a file and open the context 

menu.

▶ Select the "Additional libraries" context menu option

▶ Select "3S_CANopenMaster.lib" from the directory.

The library will be added under "Resources/Library manager." 

"3S_CANopenManager.lib" and "3S_CanDrv.lib" will have been automatically 

loaded as well.

￫ Use of the CANopen master function presumes integration of 

the library "3S_CANopenMaster.lib".
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5.3 Select gateway as field bus module

▶ Select the CAN master, e.g., "XC-CPU201..." and use the "Insert" -> 

"Attach sub element" menu option to open the selection list of CANopen 

slave modules. Once the list is open, select the "EU5C-SWD-CAN" gate-

way.

Figure 17: Select the gateway in XSoft-CoDeSys-2

5.3.1 Select the SmartWire-DT modules
▶ Change over to the register "CAN Module Selection".

▶ Select the SWD modules that you need for the SWD line. Make sure to 

select them in the correct order. This order must perfectly match the 

physical order of the SWD modules on the SWD line.

▶ To load the planned SWD configuration into the gateway, enable the 

"Create SDOs for module list" option. 

This way, the target configuration stored on the gateway can be compared 

with the planned SWD configuration created on the programming system. If 

this check box is not enabled, you will have to open the "Service Data 

Objects" tab and set the "Disable Configuration check" parameter to True 

(= 1).

￫ Data will only be exchanged if

the "Create SDOs for module list" option is enabled or the "Dis-

able configuration check" parameter = 1.
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Figure 18: Selection of SWD modules in XSoft-CoDeSys-2

Figure 19: Setting "Disable Configuration check" to "1" in XSoft-CoDeSys-2

"Support universal module M22-SWD-NOP"

It will only be possible to enable this option if the "Create SDOs for module 

list" option has been enabled previously.

5.3.2 Import of the project specific INI file into XSoft-CoDeSys-2
In addition to the standard ESD file, you can also import a project-specific INI 

file generated previously with SWD assist. Eaton PLC programming environ-

ments come with a service that makes it possible to import this INI file. The 

selection of SWD modules on the SWD line will already be assigned to the 

EU5C-SWD-CAN modular field bus module.

Follow the steps below in order to import the INI file:

▶ Change over to the register "CAN Module Selection".

▶ Click on the “Import” button.

▶ Select the INI file in the stored project folder and confirm with "OK."

All of the SWD line's SWD modules will be shown in "Selected modules."



5 Take XSoft-CoDeSys-2 into operation

5.3 Select gateway as field bus module

SmartWire-DT Gateway EU5C-SWD-CAN 01/13 MN120002Z-EN www.eaton.eu 35

5.3.3 Selecting the profile for a SWD module
Every SWD module has a standard profile. In addition, certain SWD modules 

have multiple profiles. This makes it possible to receive less or more cyclic 

data from SWD modules and process it in the application program.

For more information on which SWD modules have which additional profiles 

available and which one of them is the standard profile in each case, please 

refer to the "SmartWire-DT module" manual.

We will use the PKE-SWD-32 SWD module with standard profile 2 as an 

example in order to show how a module with a specific profile can be 

selected:

Table 3: Data profile of the SWD module PKE-SWD-32

To select the SWD module with profile 3, follow the steps below:

▶ Switch to the "CAN Module Selection" tab in the XSoft-CoDeSys-2 PLC 

Configuration window.

▶ Select the SWD module with the relevant profile, e.g., PKE-SWD-

32(Profil3).

▶ Switch to the "Service Data Objects" tab in the XSoft-CoDeSys-2 PLC 

Configuration window

▶ In the line for the previously selected SWD module - "PKE-SWD-32 

Index2102sub1" -, read the profile code shown in the line. In this particu-

lar example, the code is "0x2094."

▶ Enter a 3 into the profile code in the SWD module's "Value" column.

Selecting the SWD module with profile 3 in XSoft-CoDeSys-2

Input byte 

Profile 4 3 2 1 0

PKE-SWD-32 (Profile 2/default) – √ √ √ √

￫ Please note that the profile will not take effect until after the 

profile code has been entered.
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Figure 20: Entering profile code "0x2094" into the "Value" column

5.3.4 Changing the profile for a SWD module
If you want to change the profile for a SWD module, follow the steps below:

▶ Change over to the CAN module selection register.

▶ In "Selected modules," select the SWD module with the profile that you 

want to change.

▶ Delete the entry.

▶ In "Available modules," select the SWD module with the profile you want 

and follow the steps in ￫ Section "5.3.3 Selecting the profile for a SWD 

module“.

5.4 Parameter Definition
Parameters for communication of the gateway with the CANopen master 

and with the SWD line are also defined in the controller configuration.

These are the meanings of the individual registers.

“Basisparameter” register

This tab is used to define the I/O start addresses that are used to map the 

SWD modules to the controller map's inputs/outputs. By default, the pro-

gramming system will create a complete connection to the inputs/outputs 

used up until now. You can, however, change these values to other, unas-

signed areas.

“CAN-Parameter” register

The parameters that relate to communication with the field bus CANopen are 

entered under these settings. These include, for example, the module 

address (node ID) or the monitoring time (Node-Guarding/Heartbeat).

￫ Do not change the profile code in the "Value" column without 

first selecting the corresponding data profile.

The profile code in the "Value" column must always be identical 

to the profile code shown in the "Name" column.

￫ Only the addresses 1 to 32 may be assigned for the gateway 

￫ Section “6.1.1 PDO mapping”, page 41.
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5.5 Guarding mechanisms
Node guarding or heartbeat can be used to monitor communication between 

the gateway and the CAN master.

Node guarding

In node guarding the CAN master uses cyclical protocols to monitor the CAN 

modules. The Guard Time is minimum 200 ms. The Life Time Factor is 3.

For this the CAN master sends within the set cycle time a frame for which 

the CAN modules send an appropriate response. If a module does not 

respond, the CAN master repeats this operation. The CAN module is consid-

ered as non-existent if the number of repeat attempts exceeds the set value. 

The monitoring interval (Guard Time) and the number of repetition attempts 

can be set as required. Node guarding is activated by default.

Heartbeat

If the Activate heartbeat creation option is checked, the module emits 

heartbeats at the millisecond interval specified in Heartbeat producer time. 

The heartbeat function is deactivated if the entered value is 0.

Unlike in node guarding mode, the CAN modules and the CAN master each 

send own messages in a heartbeat mode a frame for monitoring communica-

tion. It is also possible to create dependencies in the communication pro-

cesses between the CAN modules.

However, you can use node guarding for one module and the heartbeat func-

tion for another. The figure below shows the "CAN-Parameter" register.

￫  The node guarding and heartbeat functions cannot be run for 

the same module at the same time.
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Figure 21: Adjusting the CAN parameters inXSoft-CoDeSys-2

5.6 Set device parameter of the gateway
The Service Data Objects tab can be used to configure the device parame-

ters for the gateway and, as a result, for the SWD line Table 9, page 66. 

Any settings that are changed here will be sent to the gateway by means of 

an SDO transfer when the field bus is initialized.

Figure 22: Changing settings

▶ Select the field you want and change the value as needed.
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5.7 Set the device parameters of the SWD modules

Once you have selected SWD modules new parameters are added to the 

service data objects. Thus, for example, specification of the transient behav-

ior can be performed individually. If certain SWD modules are mandatory for 

operation, you can define that the complete SWD line will not go into opera-

tion, if one of these essential modules is missing Table 10, page 67.

To find the parameters more easily the name of the module and the position 

of the SWD module in the SWD line are always appended to the actual set-

tings (0 = first module, 1 = second module etc.).

5.8 Accessing SmartWire-DT data with CANopen

Input/output addresses

The selection of the SWD modules in the controller configurator automati-

cally causes the input/output addresses of the modules to be assigned. 

Assignment of the addresses to the individual SWD modules can be viewed 

in the controller configuration.

Figure 23: SWD module addresses in XSoft-CoDeSys-2

These inputs and outputs can be addressed using the PLC's I/O image table.

￫ Please refer to the manual "SmartWire-DT Modules", 

MN05006001Z-EN for the configuration and meaning of the 

input and output data.
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5.9 Diagnostics
SmartWire-DT provides basic diagnostics in the I/O image table, as well as 

extended diagnostics based on emergency frames ￫ Section “7.4 Cyclical 

input and output data of the SWD modules”, page 62.

An extended diagnosis is reported automatically via emergency telegrams in 

the event of a diagnosis. It can also be read out for each module via an SDO 

request. You will find details on this in ￫ Section “6.2 Object Dictionary”, 

page 45 and in ￫ Section “ Extended diagnostic services”, page 63.
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6 Implementing data objects in accordance with the CANopen standard

6.1 CANopen services

6.1.1 PDO mapping
A maximum of 16 reception PDOs and 16 transmission PDOs are sup-

ported.A maximum of 128 bytes are therefore available in each communica-

tion direction for utility data interchange.

Only the four default RX PDOs and the four default TX PDOs are active in the 

device's initial state (after the gateway is reset). If additional PDOs are 

needed for transfer purposes, PDOs 5 to 16 can be activated by the user.

Ensure that the COB-IDs of the activated PDOs do not collide with the other 

CANopen modules in the same network. The addresses of the individual 

PDOs are derived as follows:

PDO 1 - PDO 4: address = NodeID + standard offset

PDO 5 - PDO 8: Adresse = NodeID + standard offset + 64

PDO 9 - PDO 12: address = NodeID + standard offset + 96

PDO 13 - PDO 16: adress = NodeID + standard offset + 32

Accordingly only node IDs in the range 1 to 32 should be used for the gate-

way.

PDO configuration

By default, byte variables are mapped to PDOs 1 to 8 and word variables are 

mapped to PDOs 9 to 16. Only these PDOs are mapped automatically.

If more than 64 byte or 32 word variables are added, they must be in free 

PDOs

6.1.2 SDO communication
The simple SDO server connection is supported (expedited SDO server). 

Segmented SDO access with a limit of 114 bytes is also supported for acy-

clic communications to SWD modules.

6.1.3 Network Management
The gateway features NMT services as per specification CiA301.
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6.1.4 Emergency telegrams for error messages
The errors that are output are governed by /DS301/. Errors are reported by 

means of an emergency telegram. The current status of the error register 

can be read out from the object list entry 0x1001/0. An error history, in which 

the last six errors are stored, can be read out of the object list entry 0x1003.

Structure of the emergency telegram

Emergency error code

If "Emcy-Error-Code" = 0xFF01 to 0xFF63 are indicated, bytes 3 to 7 will con-

tain manufacturer-specific error codes. An error code has a length of one 

byte, meaning that up to five error codes will be transmitted in bytes 3 to 7. 

Unused bytes will be padded with 0x00 (= no error). Byte 1 of the EMCY 

frame will contain the module address of the SWD line SWD module that is 

signaling the error. Tabelle 4 shows examples of manufacturer-specific error 

codes. Manufacturer-specific error codes correspond to extended diagnostic 

alarms ￫ Section “ Extended diagnostic services”, page 63.

Error codes 0xFF01 to 0xFF63 of the SWD modules

Table 4: Manufacturer-specific error codes 

Byte 0: 1 Byte Byte 2 Bytes 3-7

Emcy error code Emcy error code Error register Manufacturer-specific error codes 

Error code (hex) Meaning

00xx Error reset (no errors)

01xx general error

50xx Devices-hardware

60xx Devices-software

70xx attached modules (xx = module address)

FFxx manufacturer specific 

￫ You will find detailed information on this in the manual "Smart-

Wire-DT Modules", MN05006001Z-EN.

Error code Meaning used by

0x00 No diagnostic alarm active All devices that support the extended diagnosis

0x10 Contact in middle position RMQ

0x11 Contact short-circuit RMQ

0x13 Output overload I/O module
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Error code 0xFF00 of the SWD gateway

If "Emcy-Error-Code" = 0xFF00 is displayed, a 32-bit variable with error flags 

as shown on Tabelle 5 will be stored in the EMCY frame's manufacturer-spe-

cific area (bytes 4 to 7).

Byte 3 of the EMCY frame has a value of 0x00.

Table 5: Failure code listing for “Emcy error code” = 0xFF00

Byte: BIT dwBit Rele-
vance

Meaning

4 0 0 Info CANopen: not all reception word variables can be mapped in PDOs.

1 1 Info CANopen: not all reception byte variables can be mapped in PDOs.

2 2 Info CANopen: not all transmission word variables were able to be mapped in PDOs.

3 3 Info CANopen: not all transmission byte variables were able to be mapped in PDOs.

4 4 Fault CANopen: no valid CAN baud rate found.

5 5 Fault CANopen: no valid CANopen node ID is set (set the value 1 to 32!). 

6 6 - reserved

7 7 - Free

5 0 8 Fault CANopen: non-correctable CAN stack error.

1 9 Fault CANopen: monitoring error (node guarding/heartbeat.)

2 10 Info SWD: project configuration check

3 11 - Free

4 12 Info_x SWD: extended diagnosis of a module is pending.

5 13 Info_x SWD: CFG setting of at least one SWD module changed.

6 14 - Free

7 15 - Free

6 0 16 Fault SWD: necessary SWD module missing.

1 17 Warning SWD: optional SWD module missing.

2 18 Warning SWD: actual configuration not equal to target configuration, but compatible

3 19 Warning SWD: target configuration not equal to actual configuration, but compatible

4 20 Fault SWD: no valid target configuration present

5 21 Fault SWD: no valid project configuration present

6 22 Fault SWD: differences between target configuration and actual configuration

7 23 Fault SWD: differences between project configuration and target configuration

7 0 24 Fault SWD: short-circuit in the 15 V power supply of the SWD line

1 25 Fault SWD: internal error of the SWD coordinator

2 26 Info_x SWD: at least one SWD module is transmitting a basic diagnosis.

3 27 Fault SWD: no SWD module found.

4 28 Info SWD: the use of compatible modules is allowed.

5 29 Info SWD: all modules are registered as “optional”.

6 30 Info SWD: no comparison between target and project configuration

7 31 - Free
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After reception of the NMT telegram “Start Node” it is indicated by the dis-

patch of an EMCY-telegram that the gateway is still in the SWD mode “Fail-

safe”. This error message is taken back to the SWD mode “normal” after 

the change.

Failsafe: no initial data are transferred to the SWD modules. The initial infor-

mation of the modules is available in the PLC.

Error register

Table 6: Error register format

BIT M/O Meaning

0 m Generic error

0 0 Current

2 0 Voltage

3 0 Temperature

4 0 Communication error (overrun, error state)

5 0 Device profile specific

6 0 reserved

7 0 manufacturer specific
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6.2 Object Dictionary

The object list of the SWD CANopen gateway consists of static and dynamic 

entries.

Static entries are available in any case, dynamic entries being generated 

depending on the attached modules.

6.2.1 Static entries
CANopen-specific entries (0x1000 - 0x1FFF)

The entries in the CANopen specific area of the object list are created stati-

cally and are attainable via an SDO access as soon as the coupling unit partic-

ipates in CAN communication.

Further information on the type and use of the listed CANopen-specific 

entries in the object list can be referred to in /CiA301/.

Table 7: CANopen-specific entries

Index Subindex Data type Setpoint value

Description

0x1000 0 U32 0x

Device type (device profile number + additional information):

0x1001 0 U8 0x0

Error register

0x1003 0 - 6 U32

Error history

0x100C 0 U16 0x0

Guard time (node guarding)

0x100D 0 U8 0

Life time factor (node guarding)

0x1014 0 U32 0x80+NodeID

COB-ID EMCY object

0x1016 0 - 4 U16

Consumer heartbeat time

0x1017 0 U16 0

Producer heartbeat time

0x1018 0-4

Identity Object

0x1027 0-100 U16,(Sub0 = U8)

Module list (VendorID+DeviceID) (rw)*

0x1029 0-1 U8

Error behavior object / communication error (rw) 

0x1200 0-3

Server SDO Parameter
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User-specific entries (0x2000-0x5FFF)

0x1400 – 0x140F 0-2

RX-PDO communication parameters

0x1600 – 0x160F 0-8

RX-PDO mapping parameters

0x1800 – 0x180F 0-2

TX-PDO communication parameters

0x1A00 – 0x1A0F 0-4

TX-PDO mapping parameters

Index areas Entries

0x2000 - 0x20FF Configuration settings of the SWD configurator

0x2100 - 0x21FF Configuration settings of the SWD modules

0x2200 - 0x22FF acyclic communication with SWD modules

0x2300 - 0x23FF extended diagnostic messages from SWD modules

Index Subindex Data type Setpoint value
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Listing of the object entries

Index Subindex Data type Setpoint value

Configuration settings of the SWD configurator

Description

0x2000 0 U8 4(1..7)

Baud rate SmartWire-DT (r/w)

0x2001 0 U8 0(0..1)

Compatibility rule for exchange (0=compatible devices allowed; 1=compatible devices not allowed) (r/w)

0x2002 0 U8 0(0..1)

Presence of Slave devices (0=defined by each slave; 1=all slaves are optional.) (r/w)

0x2003 0 U8 1(0..1)

Disable configuration check

0x2004 0 U32 --

DiagFlags (Table 14.4) (ro)

0x2006 0 U8 0

Online replacement allowed (r/w)

0x2010 0 U8 0(0..255)

Delay between cyclic exchange (ms) (r/w)

Configuration settings of the SWD modules

0x2100 0..100 U8 1(0..1)

Presence of device on SWD (0 = device may not be present; 1 = device shall be present. (r/w)

0x2101 0..100 U16

Device options (parameter/presence) + slave address

0x2102 0..100 U32

CFG of devices

0x2103 0..100

Serial number of SWD device

0x2104 0..100 U8 0

Use of NOP-Modules (r/w)

0x2110 0..100 U32

Parameter of devices

Acyclic communication with SWD modules

0x2200-0x22FF 0..100 U32

Acyclic communication with modules (r/w)

Extended diagnostic messages from SWD modules

0x2300-0x23FF 0..10 1…5 bytes

Extended diagnostics of the SWD modules (ro)
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Baud rate SWD-(0x2000)

� Content

SmartWire-DT baud rate

� 4 = 125 kBaud (setpoint value)

� 5 = 250 kBaud

� Read access: Returns the SWD baud rate that is currently configured. (4 

stands for 125 kbaud.)

� Write access: valid value range of 0 - 7

Compatibility rule (0x2001)

� Content

General compatibility setting. This defines whether the replacement of a 

SWD module by a compatible module is allowed.

� 0 = replacement allowed

� 1 = replacement not allowed (setpoint value)

� Read access: returns the current compatibility setting.

� Write access: used to set the desired compatibility behavior (0 or 1)

Presence of module devices (0x2002)

� Content

This global entry defines how the SWD line behaves, if no module is found.

� 0 = it is individually settable for each SWD module whether it will be 

treated as an “optional” or “necessary” module (default setting).

� 1 = all SWD modules are treated as “optional” modules.

� Read access: returns the setting that is currently configured.

� Write access: used to define the desired behavior.

Disable configuration check (0x2003)

� Content

Via this entry it can be defined whether the SWD gateway is allowed to start 

without the performance of a comparison between the target configuration 

and the project configuration.

� 1 = the SWD gateway also starts up without comparison between 

the planned configuration and the target configuration. This setting 

is conceived for CANopen configurators that do not support down-

loading of the planned module list to the gateway.

If a planned configuration is downloaded to the gateway, a comparison of the 

configurations takes place.

� 0 = the comparison between planned configuration and target con-

figuration is mandatory (default setting).

� Read access: returns the setting that is currently configured.

� Write access: used to define the desired behavior.
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DiagFlags (0x2004)

� Content

Via this entry the current status of the diagnostic flags in accordance with 

table Tabelle 5 Page 43 can be read out.

� Read access: returns the diagnostic flags' current state.

� Write access: not permissible

Online replacement allowed (0x2006)

� Content

This entry can be used to allow or prohibit the block-by-block hot swapping of 

SWD modules.

� 0 = (default setting) Hot swapping one or more SWD modules (with-

out SetNew) is not allowed.

� 1 = Hot swapping one or more SWD modules (without SetNew) is 

allowed.

� Read access: returns the setting that is currently configured.

� Write access: Used to set the desired behavior.

Delay between cyclic exchange (0x2010)

� Content

Pause time between two SWD cycles in milliseconds

(0 - 255 ms)

� Read access: pause time that is currently configured

� Write access: pause time that should be set

At present this parameter cannot be changed.

6.2.2 Dynamic entries
The following new entries in the object list are generated each time the gate-

way is started:

Module list 0x1027

Range 0x2100 to 0x22FF: Properties of SWD modules

Range 0x6000 to 0x6FFF: utility data of SWD modules.

Specification of the dynamic object list entries is performed depending on 

the target configuration.

Input and output data of the individual SWD modules are mapped into the 

PDOs in the order of the SWD line structure.

“Input byte” entry

All input bytes of the SWD modules are listed.

“Input word” entry

All word input data of the SWD modules are lined up.
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“Output byte” entry

All output bytes of the SWD modules are lined up.

“Output word” entry

All word output data of the SWD modules are lined up.

Module list (0x1027)

� Content

Subindex = 0 (U8): the subindex 0 specifies the number of SWD modules 

registered in the target configuration.

Subindex = 1 (U16): module no: an entry (module ID) is generated with the 

order in which the SWD modules were recorded in the target configuration. 

This entry is formed from the stringing together of the vendor ID and device 

ID.

� Read access: returns data from the stored gateway target configuration.

� Write access: used to write data to the Planned configuration. Writing 

may only be performed when in

"pre-operational" status.

The list of planned modules can be transferred from the CAN master to the 

gateway via the entry “Module list (0x1027)".

Presence of device (0x2100)

These local entries define how the SWD gateway behaves, if individual mod-

ules are not found.

� Subindex = 0: 

number of modules recognized on the SWD line

� Subindex = 1 to number of SWD modules: this entry defines 

whether the corresponding module is allowed to be missing from 

the SWD line (“optional”); in this case the SWD line continues to 

run. Or whether the module is regarded as being necessary. If a 

module is missing, the SWD line is set to failsafe mode.

Preferences:

� 0 = module is allowed to be missing from the line = “optional” mod-

ule.

� 1 = the module is not allowed to be absent = “necessary” module. 

(Default setting)

� Read access: returns the setting that is currently configured for the 

specified module.

� Write access: desired setting for the specified module.

Module options + slave address (0x2101)

� Content

￫ This setting can also be defined for each module in the register 

Service data objects in the CAN-configuration of the gateway.
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� Subindex = 0: the subindex 0 represents the number of SWD mod-

ules registered in the target configuration.

� Subindex = 1 to the number of SWD modules

� Byte 1 = current SWD address of the addressed module

� Byte 2 = bit 0: module has parameter; bit 1: module is present; bit 2 

to  bit 7 = fixed on 0.

� Read access: returns data from the stored gateway target configuration.

� Write access: not permissible

Module CFG (0x2102)

� Content

� Subindex = 0:

the subindex 0 represents the number of SWD modules registered 

in the target configuration.

� Subindex = 1 to the number of SWD modules: 

Number and format of the input and output data made available to 

these modules

� Read access: returns data from the stored gateway target configuration.

� Write access: used to write data to the planned SWD configuration. The 

writing may be performed only in “pre-operational” status. The module 

must support the changed configuration settings.

Module serial number (0x2103)

� Content

� Subindex = 0: 

the subindex 0 represents the number of SWD modules registered 

in the target configuration.

� Subindex = 1 to the number of SWD modules: 

Serial number of the module found in the corresponding place

� Read access: returns data from the target configuration (stored gateway 

target configuration).

� Write access: not permissible.

Use of NOP modules (0x2104)

� Contents :

� Subindex = 0(default): the subindex 0 represents the number of 

SWD modules registered in the target configuration.

� Subindex = n = 1..100 

– 0 = SWD module n is not allowed to be replaced with an M22-

SWD-NOP universal module on the line.

– ModulNr: 1= SWD module n can be replaced with an M22-SWD-

NOP universal module on the line

� Read access: Returns the current "Use of NOP-Modules" setting for 

SWD module n.

� Write access: Writes back the current "Use of NOP-Modules" setting for 

SWD module n.
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No. of parameter bytes (0x2109)

� Contents :

� Subindex = 0: the subindex 0 represents the number of SWD mod-

ules registered in the target configuration.

� Subindex = 1-255 : The number of parameter bytes assigned to this 

module.

� Read access: data are being returned from the target configuration (con-

firmed target configuration).

� Write access: used to write data to the planned SWD configuration. The 

writing may be performed only in “pre-operational” status.

Module parameter (0x2110)

� Content

� Subindex = 0: 

The subindex 0 returns the number of known parameter entries in 

the target configuration.

� Subindex = 1 - 255: parameter data

� Read access: returns data from the target configuration. (stored gateway 

target configuration)

� Write access: used to write data to the Planned configuration. Writing 

may only be performed when in “pre-operational” status. The module 

must support the changed parameter values.

6.2.2.1 Accessing SWD module data acyclically (0x2200-0x22FF)
� Content

An index for the storage of extended diagnostic messages is reserved for 

each SWD module registered in the target configuration. (Index = 0x2200 + 

SWD address)

Subindex = 0 - 255: module specific. Acyclic access to the module data. The 

subindex is interpreted as a module index. Maximum of 120 bytes of utility 

data per access (subindex)

Access via acyclic data traffic to module data is allowed via SDO utilities in 

“operational” status only.

� Read access: module-specific

� Write access:module specific

￫ At present this property is not supported by SWD modules.

￫ The number and meaning of the available object indexes are 

described in the relevant documentation (e.g. "SmartWire-DT 

Modules", MN05006001Z-EN” manual).
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6.2.2.2 Fetching the last diagnostic alarm (0x2300-0x2363)
� Content

An index for the storage of extended diagnostic messages is reserved for 

each SWD module registered in the target configuration. (Index = 0x2300 + 

SWD module address)

A maximum of five diagnostic alarms are stored for an SWD module; the 

length of a diagnostic entry is one byte.

� Subindex 0: the number of diagnostic alarms available for this SWD 

module (values 0 - 5)

� Subindex: 1 - 5: diagnostic alarm

Access via acyclic data traffic to module data is allowed via SDO utilities in 

“operational” status only.The CAN coupling unit stores a maximum of 256 

bytes of extended diagnostic messages.

� Read access: acyclic diagnostic alarms

� Write access: not permissible

6.2.2.3 Utility data area (0x6000 - 0x7FFF)
Process data is stored in this area.

Input byte (0x6000)

� Content

� Subindex = 0: the subindex 0 returns the number of input bytes 

available in the target configuration.

� Subindex = 1 up to the number of SWD modules: 

Access to the input bytes available in the target configuration.

� Read access: returns the input byte referenced by the subindex.

� Write access: not permissible

Input word (0x6001)

� Content

� Subindex = 0: 

The subindex 0 returns the number of input words available in the 

target configuration.

Index Subindex Data type

0x6000 0 - 100 U8

I-bytes

0x6001 0 - 100 U16

I-words

0x6200 0 - 100 U8

Q-bytes

0x6201 0 - 100 U16

Q-words
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� Subindex = 1 up to the number of SWD modules: 

Access to the input words available in the target configuration.

� Read access: returns the input word referenced by the subindex.

� Write access: not permissible.

Output byte (0x6200)

� Content

� Subindex = 0: 

The subindex 0 returns the number of output bytes available in the 

target configuration.

� Subindex = 1 up to the number of SWD modules: access to the out-

put bytes available in the target configuration.

� Read access: returns the output byte referenced by the subindex.

� Write access: outputs the output byte referenced by the index.

Output word (0x6201)

� Content

� Subindex = 0: 

The subindex 0 returns the number of output words available in the 

target configuration.

� Subindex = 1 up to the number of SWD modules: 

Access to the output words available in the target configuration.

� Read access: returns the output word referenced by the index.

� Write access: outputs the output word referenced by the index.

6.3 Further CANopen specifications
� /CiA301/ CiA 301, CANopen application layer and communication profile, 

Version 4.02

� /CiA306/ CiA 306, CANopen electronic data sheet specification for 

CANopen, Version 1.3

� /CiA303-3/ CiA 303, CANopen indicator specification, Version 1.2

� /CiA801/ CiA AN801, CANopen automatic bit-rate detection
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7 What you need to know about SmartWire-DT®

This chapter provides a general overview of SmartWire-DT (SWD).

For more detailed descriptions, please refer to the following manuals:

� "SmartWire-DT The System", MN05006002Z-EN

� "SmartWire-DT Modules", MN05006001Z-EN

With SmartWire-DT you can interconnect up to 99 modules very quickly in 

simple steps. Modules can consist of switchgears as well as I/O compo-

nents.

The ribbon cable with the SWD modules and all components required for 

connecting them is called the SWD line. The SWD line starts at the blade ter-

minal as a possible connection to the control relay and then ends at the bus 

termination.

Figure 24: SWD coordinator with SWD line

a SWD coordinator

b SWD module

c Bus termination

①

② ② ② ② ② ②② ③
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Wiring assignment

An 8-core connecting cable is used by SWD coordinator to feed the SWD 

modules with power and exchange data. SmartWire-DT is self-configuring 

and addresses its modules at the push of a button.

Table 8: Configuration of the SmartWire-DT ribbon cable

The power supply for SWD coordinator and the SWD modules is connected 

via the POW terminals. The 15 V power supply of the SWD modules USWD is 

generated from POW.

If you wish to use contactors, circuit-breakers or motor starters in the instal-

lation with SmartWire-DT, a 24 V DC voltage UAUX must be fed in at AUX.

Definition of terms: components - elements - modules

The SWD components consist of SWD modules and SWD elements.

SWD modules are all those SWD components that respond to a request 

from the SWD coordinator, i.e. can exchange data. They are assigned an 

SWD module address.

SWD elements are passive SWD components that do not exchange data but 

are required for operating the SmartWire-DT network. SWD elements are, 

for example, the power feeder modules, SWD cables, adapters etc. SWD 

elements are not given an SWD module address.

SWD universal module

If functions have to be retrofitted on an installation, modifications in the hard-

ware configuration and program extension are normally very labor-intensive. 

The use of a universal module enables you to initially replace the SWD mod-

ules that are required at a later time. If the installation is then extended later, 

the planned modules are then installed instead of the universal modules. In 

this way, you will be able to retain all module addresses.A detailed descrip-

tion on connecting the universal modules is provided in the "SmartWire-DT 

Modules", MN05006001Z-EN.

Meaning

+24 V DC UAUX, Contactor control voltage

Chassis 
ground

Contactor control voltage

GND for device supply voltage and data cable

Data B Data cable B

Data A Data cable A

GND for device supply voltage and data (data A, data B)

SEL Select cable for automatic addressing of the 
SmartWire-DT modules

+15 V DC USWD, Device supply voltage
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Power feeder module

The number and the types of SWD modules determine the volume of data to 

be transferred and the current consumption.

You can use power feed modules if your application has a higher power con-

sumption than the device provides, or if the cable length of the SWD line 

causes an increased voltage drop. Calculation examples are provided in the 

"SmartWire-DT The System", MN05006002Z-EN.

Power feeder modules are power supply units that are connected addition-

ally to the SmartWire-DT when there is an increased current consumption or 

increased voltage drop. Being a passive SWD element, a power feeder mod-

ule does not have a module address.

The EU5C-SWD-PF1 power feeder module feeds the 24 V DC supply voltage 

for contactors on the SWD line.

The EU5C-SWD-PF2 power feeder module feeds both the 24 V DC supply 

voltage for contactors as well as the 15 V DC supply voltage for other SWD 

modules on the SWD line.

Figure 25: Schematic layout of an SWD line with the
EU5C-SWD-PF2 power feeder module

a EU5C-SWD-CAN

b EU5C-SWD-PF2

TN3TN2TN1

0 V

15 V

TNnTN5TN4

15 V

...

① ②
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7.1 Configurations

The following different SWD configurations are possible:

1 Planned SWD configuration

Before the SWD coordinator can start running, the device must know 

which SWD modules are present and how their parameters have been 

configured. This collected information is found in the planned SWD con-

figuration. 

Depending on the field bus protocol that you will be using, you will be 

creating the planned SWD configuration in the PLC programming envi-

ronment or in SWD assist.

2 Target configuration

Pressing the "Config" configuration button on the device will make the 

system determine the actual configuration and store it as a target config-

uration in the SWD coordinator.

3 Actual configuration

By this is meant the actual physical configuration present on the SWD 

line. Every Every time SWD coordinator is started, the actual configura-

tion is determined and compared with the stored target configura-

tion.time SWD coordinator is started, the actual configuration is deter-

mined and compared with the stored target configuration.

7.2 Changing the planned SWD configuration in SWD assist
To change the configuration of the SWD line, e.g., to add a new module or 

replace an existing one, you will have to change the planned SmartWire-DT 

configuration and import the target configuration again. Proceed as described 

in ￫ Section “3.1.1 Reading of target configuration”, page 30.

Example: Changing or replacing a module on the SWD line

Module M22-SWD-K11LED-W has one changeover contact and one white 

LED. This module is to be replaced with an M22-SWD-K22LED-W module, 

which features two changeover contacts and one white LED. In order to 

change the module, you would proceed as follows:

▶ Switch the power supply off at the device.

▶ Pull the M22-SWD-K11LED-W out of the external device plug.

▶ Plug the M22-SWD-K22LED-W into the external device plug.

▶ Switch on the power supply.

The SWD LED will show a red light, indicating that, as expected, the mod-

ules on the SWD line do not match the target configuration stored on the 

device.

￫ Please note that the planned SWD configuration and the project 

configuration are not the same thing. 

While the planned SWD configuration describes the parameters 

and the layout of the modules on the SWD line, the project con-

figuration is the description for the controller as such.
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▶ Press the "Config" configuration button on the front of the device.

The device will detect all the modules currently on the SWD line and store 

them in the device as a target configuration.

The SWD LED will show a green light, as the modules on the SWD line will 

match the target configuration.

The Config LED will show a red light, as the modified target configuration will 

no longer match the planned SWD configuration. You will now have to make 

them match again by using SWD assist or the PLC programming environ-

ment.

In order to modify the planned SWD configuration in SWD assist, you would 

proceed as follows:

▶ Start SWD assist.

▶ Open the "*.swd" application file with File -> Open

▶ Switch to the Project view or turn off the Communication view by clicking 

on the "View" -> "Communication view" button.

▶ Replace the M22-SWD-K11LED-W module in the Project view. To do so, 

go to the device catalog and drag M22-SWD-K22LED-W to drop it where 

M22-SWD-K11LED-W is located on your workspace.

The SWD line will show the symbol for M22-SWD-K11LED-W instead of the 

original module.

▶ Save the changed project file „*.swd“ in the PC.

▶ In order to establish a connection to the device, first switch to the Com-

munication view by clicking on the "View" > "Communication view" but-

tons.

▶ Click on the "Connection setup" button and then on the "Online" button.

The device information in SWD assist will show that the planned SWD con-

figuration and the target configuration in the device still do not match. 

Because of this, the planned SWD configuration in SWD assist will have to 

be transferred to the device.

▶ Store the modified planned SWD configuration on the device. To do this, 

click the "Configurations 

in the device" button and then the "PC=>device" button.

The device information will show the STOP device status. 

The Config LED will show a green light. This indicates that the target config-

uration and the planned SmartWire-DT configuration match. The device can 

now run.

Device:

Project. ≠ Target config.

SWD status:

STOP
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7.3 SWD cycle time

The SWD cycle time is the time required for the cyclic exchange of data 

between the coordinator and all modules using a common data frame on the 

SWD line. 

The SWD gateway is the coordinator.

The SWD cycle time does not depend on the number of modules on the 

SWD line as much as it does on the amount of payload data that the summa-

tion frame needs to transmit. Within this context, "payload data bytes" refers 

to the number of input and output bytes of a module.

There are commonplace modules, such as switches, that transmit little pay-

load data. However, there are also modules with multiple settings and read-

out values, such as motor-protective circuit-breakers. 

To calculate the SWD cycle time, each byte is counted as 10 bits, since a 

start bit and a stop bit are required for each byte for synchronization pur-

poses. The SWD cycle time can be calculated using the following formula:

n = Number of user data bytes.

C  = Baud rate [kBit/s]

nTN = number of modules

Example:

The following values are given:

Input bytes = 13 bytes

Output bytes = 8 bytes

Modules: 9

Baud rate = 125kBit/s

n = Number of user data bytes = 21

SWD cycle time tp [ms] = 1 n · 10 bit + 2 bit · nTN + 30 bit · 10

C

SWD cycle time tp [ms] = 1 21 · 10 bit + 2 bit · 9 + 30 bit · 10 = 4.224 ms

125 kBit/s
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Figure 26: SWD cycle time based on the amount of transmitted payload data bytes

a 125 kBit/s: 1 SmartWire-DT module with n user data bytes

b 125 kBit/s: 99 SmartWire-DT module with n user data bytes

c 250 kBit/s: 1 SmartWire-DT module with n user data bytes

d 250 kBit/s: 99 SmartWire-DT module with n user data bytes

When the baud rate doubles, the SWD cycle time is cut in half. In the exam-

ple above, the SWD cycle time goes from 4,224 ms at 125 kbit/s to 2.112 ms 

at 250 kbit/s.

12

20

28

36

44

52

60

68

76

84

10

18

26

34

42

50

58

66

74

82

0

10

20

30

40

50

60

70

80

90

100 200 300 400 500 600 700 800 900 1000

n [Bytes]

tp
 [m

s]

②

①

42
4138

3734

3330

2926
2522

2118

1714
1310

96
5

④

③



7 What you need to know about SmartWire-DT®

7.4 Cyclical input and output data of the SWD modules

62 SmartWire-DT Gateway EU5C-SWD-CAN 01/13 MN120002Z-EN www.eaton.eu

7.4 Cyclical input and output data of the SWD modules

All the inputs and outputs of the SWD modules that are present are stored in 

a data storage area inside the SWD coordinator. This data storage area is 

referred to as the "process image. " The input data can have a maximum size 

of 800 bytes, while the output data can have a maximum size of 642 bytes. 

In total, the data area must not exceed 1000 bytes. The cyclic exchange of 

data between the SWD coordinator and the SWD modules takes place in a 

common data frame.The input data can consist of several bytes, depending 

on the module. This input data contains information such as switch positions 

and diagnostic information.

The modules' input and output data is available to the PLC programming 

environment. To find out more about how it can be accessed, please refer to 

￫ Chapter 5 "Take XSoft-CoDeSys-2 into operation“, page 31.

Diagnostics possibilities

The SWD coordinator can provide the following diagnostic information:

� Cyclic diagnostic information

� Extended diagnostics information

Cyclic diagnostics information

SmartWire-DT provides you with cyclical diagnostic information. This infor-

mation can be evaluated in the program and used for further control tasks.

This basic diagnostic information is coded in the normal process image of 

each SWD module. The information about whether the SWD module is 

exchanging data normally or whether diagnostic alarms are currently present 

is provided on all SWD modules in the first input byte (byte 0) at bit positions 

4 and 6.

Example of input and diagnostic data

The M22-SWD-K11-LED-R function element has a red LED for illuminated 

pushbuttons and the two switch states 0 and 1. With cyclical input data of 

one byte, it contains information on switch position and diagnostic informa-

tion.

Byte 0:

 DANGER

Persons, systems and machines may be put at risk if an N/C 

contact is misinterpreted. When using N/C contacts always 

evaluate the PRSNT and DIAG diagnostic bits of this module.

7 6 5 4 3 2 1 0

Diagnostic data Input data

SUBST PRSNT – DIAG – – NO1 NC1
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The diagnostic bits of the individual SWD modules can be looked up in the 

"SmartWire-DT Modules", MN05006001Z-EN.

Example for output data:

The M22-SWD-K11-LED-R function element has a red LED for illuminated 

pushbuttons and the two switch states 0 and 1. With cyclical output data of 

one byte, it contains information on switch position and diagnostic informa-

tion.

Byte 0:

Extended diagnostic services

If a SWD module is signaling "Diagnose," i.e., if bit 4 of input byte 0 is set to 

1, the corresponding details can be obtained by evaluating the extended diag-

nostic services.

BIT designation Meaning

0 NC1 = Normally Closed 0: contact actuated
1: contact not actuated

1 NO1 = Normally Open 0: contact not actuated
1: contact actuated

2 Not used -

3 Not used -

4 DIAG 0: no diagnostic alarm
1: Diagnostic alarm present

5 Not used -

6 PRSNT 0: module not present
1: module present

7 SUBST 0: planned module is present
1:  M22-SWD-NOP(C) universal module present

7 6 5 4 3 2 1 0

– – – – – – – Q0

BIT designation Meaning

0 Q0 Control section LED

1 Not used –

2 Not used –

3 Not used –

4 Not used –

5 Not used –

6 Not used –

7 Not used –
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If you were to determine the detailed states for an M22-SWD-K11-LED-R 

function element as an example of a SWD module, you would be able to get 

information on the following:

If there is a diagnostic alarm present for an SWD module, this means that 

there is a fault on this module. Using the SWD assist software you can dis-

play the extended diagnostic alarms to identify the faults more closely. 

Proceed as follows for SWD assist to display the extended diagnostic alarms:

▶ In SWD-Assist, switch to the Communication View by clicking on the 

"View" -> "Communication View" menu option.

▶ Connect to the SWD coordinator by clicking on the "Connection estab-

lishment" button -> "Online."

▶ In the workspace, click on the module that you want to diagnose.

▶ In the Properties field choose the "Diagnostics buffer" tab.

The table in the Properties field shows you the extended diagnostic alarms. 

The alarms are logged and displayed with a time stamp. The time stamp is 

based on the system time of your PC. The code is displayed in decimal nota-

tion. Diagnostic alarms can be categorized as follows:

� Code < 1000:

Alarm comes directly from the module; the code is the same as a fault on 

field bus systems. These fault messages are described in the "Smart-

Wire-DT module" manual. The error codes stated there are in hexadeci-

mal notation.

� Code ≧ 1000:

Alarm was generated by SWD coordinator as the SWD module can no 

longer send.

The extended diagnostic alarms are not retentive in the SWD assist.

If SWD coordinator is switched off, the diagnostics buffer is cleared.

Further information on extended diagnostics is provided in the Online Help of 

SWD assist.

For more information on how to evaluate the extended diagnostic messages 

in the PLC programming environment, please refer to ￫ Chapter 5 "XSoft-

CoDeSys in Betrieb nehmen“, page 31.

&Value Meaning

0x10 The contact is longer than four seconds in the middle position.

0x11 There is a short-circuit in the contact.
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7.5 SWD device parameters

In the case of EU5C-SWD-CAN, the device parameters can be configured in 

the PLC programming environment. 

A "required module" is a module for which the  „DevicePresence“ = "1" so 

that it is enabled.

The „All slaves optional“ and „DevicePresence“ device parameters define 

whether there is a SmartWire-DT error when the actual configuration is dif-

ferent from the target configuration.

The "Compatible devices allowed" and "AcceptUniversalModul" device param-

eters define whether there is a SmartWire-DT error when the target configu-

ration is different from the planned configuration.

"Online replacement" device parameter

The „Online replacement“ device parameter makes it possible to hot swap 

SWD modules block by block. In addition, the„All slaves optional“ parameter 

must be set to "1". Otherwise, the entire line will be disabled if communica-

tions with one or more SmartWire-DT modules are lost.

When „Online replacement“ is enabled, the SmartWire-DT coordinator will 

perform an automatic addressing routine if it detects any differences 

between the target configuration and the actual configuration when compar-

ing them. The comparison between the planned SmartWire-DT configuration 

and the target configuration will continue to be performed.

Examples

Remember that if „All slaves optional“ is set to "1"and is enabled, the SWD 

line will continue to run even if a module on the line drops out - regardless of 

whether „Online replacement“ is enabled or disabled. 

When „Online replacement“="0", this means that the device parameter is 

not enabled. If the module is replaced with an identical module while the 

power is off, the target configuration will have to be imported again after the 

power is turned back on. The SWD line will not start running. In other words, 

the user is required to intervene.

When „Online replacement“="1",  this means that the device parameter is 

enabled. If the module is replaced with an identical module while the power 

is off, a new target configuration will be automatically imported. If this 

imported target configuration matches the planned SmartWire-DT configura-

tion, the SWD line will start running. The SWD line will also start running if 

the new modules are compatible with the planned SmartWire-DT configura-

tion and the "Compatible devices permissible"="1"is enabled.

NOTICE

Hot swapping modules on the SWD line is only allowed in con-

junction with the SWD4-FFR-PF1-1 power supply module and 

SWD4-FFR-ST1-1 cable adapter SmartWire-DT components.
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7.5.1 Device paramters of the SWD gateway

Table 9: Device parameter SWD coordinator

Device parameter adjustable 
on SWD coordinator

VALUE Reaction SWD line

Baud rate SmartWire-DT 125 KBaud
250 KBaud 

125 KBaud  =setpoint value

Baud rate on SWD line
Setting options:
�  125 KBaud (setpoint value)
� 250 kBaud  (operating system V1.10 and higher)

All slaves optional
(0 = No;
1 = Yes)

0 0=Default setting
The  device parameter on each SWD module is used to define 
whether the module is optional ￫ Section “ DevicePresence”, 
page 67.

1 All SWD modules are optional.
The SWD line can be run with any number of failed SWD modules. 
Data will be transferred to the field bus master. 

The ￫ Section “ DevicePresence”, page 67  setting in the SWD 
modules will have no effect.

Compatible devices allowed
(0 = No;
1 = Yes)

0
0=Default setting
The  planned SWD modules in the SWD configuration must comply 
with the SWD modules of the stored gateway target configuration. 
If they do not, no data will be transferred to the field bus master.

1
Data will be exchanged if the SmartWire-DT modules connected to 
the SWD line are identical to or compatible with the SmartWire-DT 
modules in the planned SmartWire-DT configuration.
If they do not, no data will be transferred to the field bus master
This is displayed via the status LED on the device.
You will find the list of devices that are compatible with one 
another in ￫ Table 30, page 106.

Disable configuration check
(0 = No;
1 = Yes)

0 The planned SWD configuration and the target configuration will 
be compared. If they are not identical, no data will be exchanged.

1 The planned SWD configuration and the target configuration will 
not be compared. 

This setting must be used for all configurators except XSoft-
CoDeSys-2, since only XSoft-CoDeSys-2 supports downloading a 
CAN configuration onto the CANopen gateway.

Delay between cyclic data 
exchange
(0 - 255ms)

At present the value cannot be changed.

Online replacement
(0 = No;
1 = Yes)

0 0=Default setting;
New SWD modules on the SWD line must always be assigned an 
address by importing the target configuration.

1 This setting enables block-by-block hot swapping for SWD 
modules without having to explicitly reconfigure them via the 
device by pressing the configuration button.

In addition, the "All slaves optional" toparameter must be set to 
"1". Otherwise, the entire line will be disabled if communications 
with one or more SmartWire-DT modules are lost.
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7.5.2 Device parameters of SWD modules

Table 10: Device parameters of SWD modules

Device parameter 
adjustable on SWD 
module

Value Reaction SmartWire-DT

DevicePresence
(0 = optional;
1 = mandatory)

1 Required SWD module
1=Setpoint value
The SWD module must be present when the system 
starts and during operation. 
A missing SWD module causes following:
� PRSNT diagnostic bit to be set to "0"
� DIAG diagnostic bit to be set to "1"
� The SWD line will not start running or will be 

stopped, as the case may be.

Note:

This device parameter will only take effect if the coordi-
nator's " „All slaves optional“ device parameter is 
disabled, i.e., if it has a value of   "0".

0 The SWD line will keep running even if the SWD module 
is missing or defective.

AcceptUniversalModule
(0 = No;
1 = Yes)

0 0=Setpoint value
The SWD module can not be replaced by a universal 
module M22-SWD-NOP(C).

1 The SWD module can be replaced by a universal module 
M22-SWD-NOP(C).

Q_byte… 0 - 255 0=Setpoint value
The actual value of the outputs that is output when the 
master starts, before the first data are sent by the PLC 
to the module.



7 What you need to know about SmartWire-DT®

7.5 SWD device parameters

68 SmartWire-DT Gateway EU5C-SWD-CAN 01/13 MN120002Z-EN www.eaton.eu

7.5.3 Application cases for the effective use of the device parameters
Compatible devices allowed enabled

The system is already running and both the target configuration and the 

planned SWD configuration are stored on the SWD coordinator. The SWD 

coordinator is switched off in order to replace a defective module. As you 

don't have a replacement of the same type, you use a compatible type 

according to the table. 

When you switch the SWD coordinator back on, the actual configuration will 

be determined.The automatic configuration comparison will detect the new 

module and signal this discrepancy by showing a solid red light on the Config 

LED. You will then have to press the "Config" configuration button. After this, 

the SWD coordinator will import the new target configuration. The Smart-

Wire-DT coordinator will compare the target configuration with the planned 

SmartWire-DT configuration and detect a difference between both. The sys-

tem will then check whether the "Compatible devices permissible" option has 

been enabled.If it has, the SWD coordinator will check whether the module 

in the target configuration is really compatible with the module in the planned 

SWD configuration. If it is, there is no SmartWire-DT error and the SWD line 

will start running.

"AcceptUniversalModul" enabled

You've designed a system and you want to first use a universal module for a 

specific module, as the actual specific module will be installed as part of a 

later upgrade. To do this, you enable the „AcceptUniversalModul“=„1“ 

device parameter.

This makes it possible for the module in the planned SmartWire-DT configu-

ration to be replaced by a universal module in the target configuration.Once 

you install the universal module on the de-energized SWD line, you switch on 

the SWD coordinator and press the "Config" configuration button to import 

the target configuration. The check against the planned SWD configuration 

then shows that the configurations do not match. After this, the SWD coordi-

nator checks whether the „AcceptUniversalModul“=„1“ device parameter is 

enabled for this module. If it is, the SWD line will start running. 
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7.6 Faults on the SWD line

Different events can occur in conjunction with the SWD line, which require 

rectification.

Missing or faulty module

If the SWD coordinator determines that the actual configuration is missing a 

SWD module from the target configuration, the PRSNT diagnostic bit will be 

set to 0.

If the „All slaves optional“ = „1“ , missing modules will not trigger a Smart-

Wire-DT error. The „DevicePresence“ device parameter, which can be set 

individually for each SmartWire-DT module, will not be checked in this case. 

The Config LED and the SWD LED will show a solid green light.

If the „All slaves optional“= „0“ , the „DevicePresence“ device parameter 

on the individual SmartWire-DT module will be checked. 

If the missing SmartWire-DT module is not a required SmartWire-DT module, 

the SWD line will keep running and will continue to work with the remaining 

SmartWire-DT modules. The Config LED and the SWD LED will show a solid 

green light.

If, however, the SWD module is a mandatory module, the SWD LED will 

show a flashing red light and the SWD line will not start running. The Config 

LED will show a solid green light, while the SWD LED will show a flashing 

red light.

If this error occurs during ongoing operation, e.g., because a module 

responds too late or is faulty, the SWD line will resume operation as soon as 

the error is fixed. A restart is not necessary.
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"Wrong" or faulty module

An “incorrect” module is one that SWD coordinator finds which, when deter-

mining the actual configuration, is not expected in the target configuration. 

This means that if you replace a pushbutton actuator with one of the same 

type when the SWD line is switched off, it will be identified as an “incorrect” 

module by the SWD coordinator.

An “incorrect” SWD module on the SWD line can only be found on startup 

since the replacement of an SWD module is not permitted when the device 

is switched on. The following therefore distinguishes which cases an “incor-

rect” module can occur on an SWD line after startup.

If the SWD coordinator determines that an SWD module of the actual config-

uration does not match the target configuration, it defines it as an “wrong” 

module. The DIAG diagnostic bit stays at 0.

The same response also takes place if SWD coordinator finds more modules 

on the SWD line than is stored in the target configuration.

With a "wrong" module the SWD line does not go into operation. The Config 

LED is green, the continuous light; the SWD-LED is not flashing red.

You may wish to permit the “incorrect” module, because, for example, you 

wish to replace a faulty SWD module with a new one. Perhaps you wish to 

replace an SWD module with a compatible SWD module or with a universal 

module. In that case read further in ￫ Section “ Compatible devices 

allowed enabled”, page 68 and ￫ Section “ "AcceptUniversalModul" 

enabled”, page 68.

In any case, you will have to press the "Config" configuration button. 

￫ Bear in mind that the serial number of the module is also exam-

ined for matching as well as the module type.
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7.7 LEDs on the device

The SWD-LED indicates whether the actual configuration of the SWD line 

matches the target configuration.

The Config LED is used to indicate the result of the configuration comparison 

between the stored target configuration and the planned configuration. This 

comparison takes into account all relevant device and module parameters. 

Table 11: LED SWD coordinator

LEDs on the module

Table 12: LEDs on the relevant module

LED Status Data 
exchange 
coupling unit 
PLC

SmartWire-DT off no supply voltage at POW
no target configuration present

No

Green continuous light Actual configuration = Target configuration yes

green flashing The SWD modules are being addressed and 
the actual configuration is being determined,
e.g., after switching the system on or down-
loading a planned SWD configuration with s

No

red flashing actual configuration ≠ target configuration 
e.g., a required module is missing or
one module too many

No

Red continuous light No SWD line present
No 15 V DC device voltage present

No

Config off No planned SWD configuration is available, 
because e.g.
� Initial Commissioning or
� Program in SWD coordinator was deleted

No

Green continuous light  target configuration = defined planned SWD 
configuration

yes

Green flashing A module from the planned SWD configura-
tion has been replaced with a compatible 
module in the target and actual configura-
tions

yes

Red continuous light Target configuration ≠ defined planned SWD 
configuration

No

Changes from perma-
nent orange to red

The gateway is in firmware update mode 
when the POW LED is off. The firmware 
update mode can be left by switching on the 
supply voltage again.

No

LED Status

Module-LED off no 15 V supply voltage

green flashing Waiting for addressing

green fast flashing Error on module and diagnostic alarm is "1"

Green continuous light Module matches the target configuration.
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Further information is provided in the manual "SmartWire-DT The System", 

MN05006002Z-EN.

7.8 SWD assist
The SWD assist planning, ordering and commissioning program can be used 

to perform the following functions, among others:

� Selecting modules, as well as a gateway

� Entering device parameters for the SWD gateway and the

SWD modules

� Entering SWD network parameters 

� Status indication of the inputs/outputs

� Wiring test

� Reading of the stored actual configuration

� Importing the planned SWD configuration stored on the gateway

� Comparison of the target and actual configuration

� Display of cyclical and acyclical diagnostics messages

The Online Help function provides a detailed description of how to use SWD-

Assist. In order to open it, click on the "?" icon on the SWD-Assist menu bar 

or press the F1 key.
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8 Appendix

8.1 Dimensions

EU5C-SWD- CAN

Dimensions W x H x D mm 35 X 90 X 126.5 

inch 1.38 X 3.54 X 4.98

Dimensions a mm 122

inch 4.8

Space units (SU) width 2

Weight kg 0.16

lb 0.35

Mounting Considerations Top-hat rail IEC/EN 60715, 35 mm or screw fixing usingfixing brackets 
ZB4-101-GF1 (accessories).

Mounting position Horizontal or vertical

Figure 27: Dimensions EU5C-SWD- CAN
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8.2 Technical data

8.2.1 Standards

8.2.2 General ambient conditions

EU5C-SWD- CAN

Standards EN 55011, EN 50178, EN 61131-2, IEC EN 61000-4, IEC60068-2-6, 
IEC60068-2-27

EU5C-SWD- CAN

Ambient mechanical conditions

Degree of protection (IEC/EN 60529, EN50178, VBG 4) IP20

Vibrations (IEC/EN 61131-2:2008)

constant amplitude 0.15 mm Hz 5 – 8.4

constant acceleration 1 g Hz 8.4 – 150

Mechanical shock resistance (IEC/EN 60068-2-27) 
semi-sinusoidal 15 g/11 ms

Impact 
resis-
tances

9

Drop to IEC/EN 60068-2-31 Drop height mm 50

Free fall, packaged (IEC/EN 60068-2-32) m 0.3

Ambient climatic conditions

Operating ambient temperature (IEC 60068-2) °C -25 to +55

Condensation prevent with suitable measures 

Storage °C –40 to +70

Relative humidity, non-condensing (IEC/EN 60068-2-30) % 5 – 95

Electromagnetic compatibility (EMC)

Overvoltage category II

Pollution degree 2

Electrostatic discharge (IEC/EN 61131-2:2008)

 Air discharge (Level 3)  kV 8

 Contact discharge (Level 2)  kV 4

Electromagnetic fields (IEC/EN 61131-2:2008)

80 - 1000 MHz V/m 10

1.4 - 2 GHz V/m 3

2 - 2.7 GHz V/m 1

Radio interference suppression (SmartWire-DT) EN 55011 Class A

Burst (IEC/EN 61131-2:2008, Level 3)

Supply cables  kV 2

Fieldbus cable  kV 1

SmartWire-DT cables  kV 1

Surge (IEC/EN 61131-2:2008, Level 1)

Supply cables/Fieldbus cable  kV supply cable: 0.5,
bus cable: 1 

Radiated RFI (IEC/EN 61131-2:2008, Level 3) V 10
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8.2.3 Power supply

EU5C-SWD- CAN

DC power supply AUX

Rated operational voltage V 24 DC -15 % +20 %

Residual ripple of input voltage % F 5

Protection against polarity reversal Yes

Maximum current Imax A_x CE:31)

UL: 21)

Short-circuit strength no,
external fuse
CE: FAZ 3
UL: FAZ 2

Heat dissipation W Normally 1

Potential isolation

from power supply POW Yes

from serial interface No

from SmartWire-DT No

from fieldbus interface Yes

Rated operating voltage of 24-V-DC modules V typical UAUX - 0.2

DC power supply POW

Supply voltage V 24 DC -15 % + 20 %

% F 5

Yes

Rated operational current Ie A_x 0.7

Overload proof yes

Inrush current and length 12.5 A/6 ms

Heat dissipation at 24 V DC W 3.8

Potential isolation between UPow and 15 V SmartWire-DT supply voltage No

Potential isolation

from power supply POW Yes

from serial interface No

from SmartWire-DT No

from fieldbus interface Yes

Bridging voltage dips ms 10

Repeat rate s 1

Status display POW-LED
plain color: orange

1) When the total power consumption > Imax , 
an EU5C-SWD-PF1 or EU5C-SWD-PF2 power feeder module has to be used.
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8.2.4 SmartWire-DT®

EU5C-SWD- CAN

SmartWire-DT power supply USWD
(generated from the POW supply voltage)

Rated operational voltage Ue V 14.5 g 3 %

max. current Imax A 0,71)

Short-circuit strength Yes

Potential isolation

from power supply POW No

from power supply AUX Yes

from serial interface No

from fieldbus interface Yes

Connection supply voltages

Connection type Push in terminals

solid mm2 0.2 – 1.5 (AWG 24 – 16)

flexible with ferrule mm2 0.25 – 1.5

SmartWire-DT line

Module type SWD configurator

Max. number of SmartWire-DT modules  99

Baud rate kBd 125/250

Interface standard of data cable RS485

Address setting automatically via configuration 
button

Status display Multi-color SWD-LED: orange/
green/red
Dual colored Config LED: green/red

Connections Plug, 8-pole

Plug connectors Blade terminal SWD4-8MF2

Bus termination resistor SWD line integrated in the device: 
the end of the SWD line must be 
terminated with
SWD-RC8-10

1) When the total power consumption > Imax ,
an EU5C-SWD-PF2 power feeder module has to be used.
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8.2.5 Field bus interface CANopen

8.2.6 Diagnostics interface

EU5C-SWD-CAN

Fieldbus interface

Function CANopen slave

Default port None

Protocol CANopen

Input data, maximum Byte: 128

Output data, maximum Byte: 128

Baud rate MBit to 1 MB

Baud rate detection automatic

Address setting automatic

Module address 2 – 32

Address setting with DIP Switch

Status display interface CAN-LED
two-colored: red/green

Bus termination resistor switched via dip switch at the gateway

Terminal types 1 x SUB-D plug, 9-pole

Potential isolation

from power supply POW / AUX yes

from serial interface yes

from SmartWire-DT yes

EU5C-SWD- CAN

Diagnostics interface

Part no. RS232

Terminal types RJ45

Potential isolation

from power supply POW / AUX No

from SmartWire-DT No

from fieldbus interface Yes
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8.3 Compatible SWD module types

You can find permissible SWD modules and their permissible replacement 

types:

Table 13: List of types that are compatible with one another

Part no. Description permissible replace-
ment type 1

permissible replace-
ment type 2

RMQ function elements (front mount)

M22-SWD-K11 Function element, 2 pos. front M22-SWD-K22  

M22-SWD-K22 Function element, 3 pos. front  

M22-SWD-LED-W Function element, LED W front M22-SWD-K11LED-W M22-SWD-K22LED-W

M22-SWD-K11LED-W Function element, 2 pos., LED W, front M22-SWD-K22LED-W  

M22-SWD-K22LED-W Function element, 3 pos., LED W, front  

M22-SWD-LED-R Function element, LED R front M22-SWD-K11LED-R M22-SWD-K22LED-R

M22-SWD-K11LED-R Function element, 2 pos., LED R, front M22-SWD-K22LED-R  

M22-SWD-K22LED-R Function element, 3 pos., LED R, front  

M22-SWD-LED-G Function element, LED G front M22-SWD-K11LED-G M22-SWD-K22LED-G

M22-SWD-K11LED-G Function element, 2 pos., LED G, front M22-SWD-K22LED-G  

M22-SWD-K22LED-G Function element, 3 pos., LED G, front  

M22-SWD-LED-B Function element, LED B front M22-SWD-K11LED-B M22-SWD-K22LED-B

M22-SWD-K11LED-B Function element, 2 pos., LED B, front M22-SWD-K22LED-B  

M22-SWD-K22LED-B Function element, 3 pos., LED B, front  
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RMQ function elements (base fixing)

M22-SWD-KC11 Function element, 2 pos., base M22-SWD-KC22  

M22-SWD-KC22 Function element, 3 pos., base  

M22-SWD-LEDC-W Function element, LED-W, base M22-SWD-K11LEDC-W M22-SWD-K22LEDC-W

M22-SWD-K11LEDC-W Function element, 2 pos., LED-W, base M22-SWD-K22LEDC-W  

M22-SWD-K22LEDC-W Function element, 3 pos., LED-W, base  

M22-SWD-LEDC-R Function element, LED-R, base M22-SWD-K11LEDC-R M22-SWD-K22LEDC-R

M22-SWD-K11LEDC-R Function element, 2 pos., LED-R, base M22-SWD-K22LEDC-R  

M22-SWD-K22LEDC-R Function element, 3 pos., LED-R,, base  

M22-SWD-LEDC-G Function element, LED-G, base M22-SWD-K11LEDC-G M22-SWD-K22LEDC-G

M22-SWD-K11LEDC-G Function element, 2 pos., LED-G, base M22-SWD-K22LEDC-G  

M22-SWD-K22LEDC-G Function element, 3 pos., LED-G, base  

M22-SWD-LEDC-B Function element, LED-B, base M22-SWD-K11LEDC-B M22-SWD-K22LEDC-B

M22-SWD-K11LEDC-B Function element, 2 pos., LED-B, base M22-SWD-K22LEDC-B  

M22-SWD-K22LEDC-B Function element, 3 pos., LED-B, base  

DILM/MSC function elements

DIL-SWD-32-001 DIL/MSC DIL-SWD-32-002  

DIL-SWD-32-002 DIL/MSC, Manual/Auto  

PKE-SWD-32

I/O function elements

EU5E-SWD-4DX Digital module, 4 inputs

EU5E-SWD-8DX Digital module, 8 inputs  

EU5E-SWD-4D4D Digital module, 4 inputs, 4 outputs  

EU5E-SWD-4D2R Digital module, 4 inputs, 2 outputs

EU5E-SWD-X8D Digital module, 8 outputs

EU5E-SWD-4AX Analog module, 4 inputs

EU5E-SWD-2A2A Analog module 2 inputs, 2 outputs

EU5E-SWD-4PT Analog module, 4 temperature inputs

EU5E-SWD-4PT-2 Analog module, 4 temperature inputs

Part no. Description permissible replace-
ment type 1

permissible replace-
ment type 2
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